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1. Getting Started 
 

1.0 About iDesign 
 
iDesign is the professional software that offers card designing and printing solutions with complete 
support for barcodes, databases etc. A wide range of features and options makes this a powerful, but 
easy-to-use tool for any designing and printing requirement. 
 
This iDesign user manual will guide you through the use of iDesign, from creating a card, to editing, and 
to advance functions such as database commands. Please refer back to this manual if you are unsure of 
the iDesign functions during the use of the software.  
 

1.1  Software Activation/Deactivation (For Keyless only) 
If iDesign software is not activated, the “Software Activation“ window will display when start up iDesign 
software. 
 

 
 
1.1.1 Run demo version, click Run As Demo button if user need to try iDesign software before proceed 

to buy the license. 
1.1.2 Online Activation: Make sure the internet connection is connected, key in serial number, then click 

Online Activate button to activate the software,  
1.1.3 Online Deactivation/Upgrade, Offline Deactivation: (Demo Version is not available) 

 Proceed to File – Options 
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If iDesign has been activated, the Advanced button will be enabled. (Disabled in demo mode) 
 Click Advanced to go to activation screen. 

 
Make sure the internet connection is connected, key in serial number, then click Online Upgrade 
button to upgrade the software or online Deactivate to deactivate the software. 

 Offline Deactivation 
Key in serial number, then tick the Manually Activation/Deactivation check box, click 
Generate Deactivation File. 

1.1.4 Manually Activation 
Click Manually Activation/Deactivation check box. 

 
 

 Manually Activation:  
1)  Key in serial number, then click Generate Activation File button to create a SM.txt at desktop, 

email/fax it to your vendor, wait for your vendor to work out with the licence and send back the 
registration licence number. 

2)  After you received the Registration Licence Number from vendor, key in the Registration Licence 
Number here and click “Offline Activate” button to active the software. 
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1.2 Specifications 
 

1.2.1 Supported barcodes and 2-D Symbologies 

 
The iDesign supports the following one-dimensional symbologies: 

          MSI/Plessey   

          Interleaved 2 of 5  

          Interleaved 2 of 5 with Check Digit  

          Codabar Symbology  

          Code 39 or Code 3 of 9  

          Code 39 with Check   

          Code 39 Extended    

                    Code 39 Extended with Check    

          Code 93   

          Extended Code 93    

                    Code 128 Auto 

          Code 128-A    

          Code 128 B   

          Code 128 C   

          UPC A   

          UPC E    

          EAN 13  

          EAN 8  

          Postnet    
 
The iDesign supports the following 2-D barcode symbologies: 

          PDF 417   

          DataMatrix  

                    QR Code 

                    AZTEC Code 
 

1.2.2 Data sources 
  
iDesign supports the data sources with ODBC or ADO interface, including MS SQL Server, Oracle, 
Sybase, DB2, Access, Database, Foxpro, Excel, Text, Interbase, SQL Anywhere and MySQL etc. 
  

1.2.3 Systems 

Windows Vista, Windows 7, Windows 8, Windows 10 
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1.2.4 Graphics formats 
  
iDesign supports the following commonly used graphics formats: 

          Windows Bitmap (BMP, DIB, RLE) 

          CompuServe Bitmap (GIF) 

          JPEG 

          Bitmap (JPG, JPEG, JPE) 

          Portable Network Graphics (PNG) 

          Windows Metafile (WMF) 

          Enhanced Windows Metafile (EMF) 

          Windows Icon (ICO) 
 

1.3 Introduction to the main window  
  
The iDesign user interface, with its functions and commands, follows similarly to the interfaces you work 
in for other windows based software. The following will illustrate and name each part of the iDesign main 
window, and explains how each part works. 
 
 
 

 
 
 

 
 

 
The Title Bar 

The title bar displays the name of iDesign and the name of the active card template 
filename. 

 
The Menu Bar 

The Menu bar lists the available menus. A menu contains a list of commands, or actions, 
you can carry out with the Card Software. 

 
 
Close Button 

Minimize 
 Maximize 
 Close 
buttons 

Ruler 

Card Work 

Area 

Toolbars 

Menu bar 

Title bar with Template name 
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You can click the Close button to end your iDesign working session. 
 
Minimize, Maximize Button 

You can click the Maximize button to enlarge the active program window so that it fills 
the entire desktop, or you can click the Minimize button to reduce the window to an icon. 

 
The Scroll Bars 

When the Card Work Area is zoomed-in beyond the size of the window, Scroll Bars 
appear so that you can use to view information that exists beyond the borders of the 
window. Drag a Scroll Box or click one of the Scroll Arrows to scroll the window and 
move the desired part of the card image into view. 

 
The Standard Status Bars 

Messages appearing at the bottom left of the window is called the status bar. These 
messages describe what you are seeing and doing in iDesign window as you work. It will 
display the name of the tool of the tool’s button you desired or provides a short message 
telling you what that command will do when you rollover with your mouse pointer. 

 
The Toolbars 

You can use toolbars for quick access to some of the most commonly used commands 
and tools. Tooltips explaining the functions of each button are displayed if you rollover the 
mouse pointer over the desired button. 

 
The Card Work Area 

All your work to layout a card is done in the Card Work Area. This area displays a card 
outline depicting the physical limits of the card. Any objects placed outside the card 
borders will not be printed 

 
The Rulers 

iDesign includes Rulers to help you align your artwork and arrange image elements 
symmetrically. Rulers can be configured to display inches or millimeters. To set your unit 
of measure, select View -> Metrics  

 
The Grid 

An invisible network of lines covering the card. As you draw objects, they will co-interact 
with the grid if Snap To Grid is checked in the View menu. You can turn it on and off 
using the Grid command from the View menu. 

 

1.4 Working with commands 
 
The user uses a command to instruct an operation to be carried out. There are 3 methods to choose 
commands. You can choose a command from the menu, or from the toolbar, or using shortcut keys. 
 

Toolbar Commands 
iDesign toolbars provide you with one-step access to lots of tasks. You can draw a 
rectangle, insert an image, define a bar code, edit text and much more - all with just a 
click of the mouse button. 
For more information about each of the Card Software toolbars, see the details in their 
respective chapter on Toolbars and Tools. 
 

Menu Commands 
Commands are grouped in menus. Some commands carry out an action immediately; 
others display a dialog box so that you can select options. You can select commands 
from the menu bar. 
   

Shortcuts 
You can use a mouse shortcut to give you quick access an object’s property sheet, or to 
display a shortcut menu. 
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To display the Shortcut menu when you have an object selected. 
 Move the mouse pointer over the selected object. 
 Right click mouse button. The Shortcut menu appears. 
 Choose the command you want to perform. 

 

 
 
To display an object’s property sheet. 

 Double click on the object  
 

OR 
 
 Right click on the object  
 Choose Properties when the shortcut menu appears. 
 The properties dialogue box will pop up. 

 

 
 
 

You can also activate commands by pressing the keyboard shortcut keys listed on the 
menu to the right of the command. iDesign uses many of the shortcut keys found in other 
Windows programs. You find a list of shortcut keys in Chapter 7 - “Keyboard Shortcuts”. 
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1.5 Setting Up Path 
 
You may want to specify a folder to contain all your card template layouts and image file.  The system will 
then look into the folders each time to access a template or an image file. 
 

 Proceed to File – Options 

 
 Click Browse to select a picture folder and template folder to store the default path for 

looking for a template or picture. 
 Click OK to save the default path for both setup. 

 

 



 10 

2. Creating Card 
 
This chapter will show the procedures to open existing card design template, save the work and to create 
a new card. 
 

2.1 Open card design template 
  

 To open an existing card design template, click on the Open button  on the toolbar. 
 In the Open dialogue box, select or type the design template name that you want to open 

 

 
 

 Click on the Open button 
 If the card file you want is not listed, scroll to another drives or folders from the Open 

dialogue box to look for the desired design template.  
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2.2 Save card design template 
 

 To save an existing card design template, click on the Save button  on the toolbar. 
 
 

 
 

 When you save the card for the first time, the Save Dialogue box will appear. 
 In the Save dialogue box, type the desired design template name that you want to save the 

design template as.  
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2.3 Displaying card information 
 
Card Properties command is used to display information about the card design template. 
To open the Card Properties dialog box, select from the menu bar File > Card Properties. 

 

2.3.1 General tab 
 

 
 

 
 General tab displays the card Author, creation date, the workspace and card colors and brief 

description of the design template. 
 

To select custom color using workspace 
 To change color for grid, workspace, front and back, click on the color box beside each 

function. The color dialogue box pops up. 
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 Select the desired color from the list of colors.  
 If you want to use a custom color, click on Define Custom Colors button.  

 

 
 
 Select the desired custom color from the color picker 
 Click Add to Custom Colors button to select the desired custom color 
 Click OK to complete selection   
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2.3.2 Objects List 

 

 
 

 Objects List allows you to see a list of all objects of a card, and from where it’s possible to 
delete or edit the design templates’ properties. 

 Click on any one of the object in the list will show you the relevant data in the “Preview” 
window.  

 You can specify to each object general properties by checking “Don’t print”, “Read only” 
and “Visible”. 

 To edit these objects, click Properties button. “Text Shape Properties”, “Image Shape 
Properties” or other shape properties dialog box will pop up according to the different 
objects.       

 To remove an object, click “Delete” button. 
 

2.4 Creating a basic card 
  
This section shows the procedures to create a basic card using some of the more popular tools in iDesign. 
 

2.4.1 Create a new card 
 

 To create a new card design template, click on the New button  on the standard toolbar. 
 

2.4.2 Card setup 

 
 The card can be created in either landscape or portrait mode. The card defaults to landscape 

mode on creation.  
 To set the card to portrait mode, select from the menu bar File > Card Setup. The Card 

Setup dialogue box will pop up. 

List of 

Objects 
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 Select Portrait in the Card Setup Dialogue box.  
 

2.4.3 Adding a Line 
 

 Click the Line tool  on the shape toolbar; the pointer changes from an arrow to a cross. 
 Move the pointer to the point on the card where you want to place one end of the line. 
 Click and hold the left mouse button on the card work area and drag it in the direction 

desired. As you drag, a line is drawn, with one end fixed where you began to drag, and the 
other end following the pointer.  

 Continue dragging until the line is the desired length. 
 Release the mouse button. The line appears on the card. 

  

2.4.4 Adding a Rectangle 
 

 Click the Rectangle tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the point on the card work area where you want to place the upper left 
corner of the rectangle. 

 Press and hold the left mouse button and drag in any direction desired. As you drag, a 
rectangle forms with one corner fixed where you began to drag, and the other corner 
following the pointer.  

 Continue dragging until the rectangle is the desired size. 
 Release the mouse button. The rectangle appears on the card. 

 

2.4.5 Adding a Round Rectangle 
 

 Click the Round Rectangle tool  on the shape toolbar; the pointer changes from a 
pointer to a cross. 

 Move the pointer to the point on the card work area where you want to place the upper left 
corner of the rectangle. 

 Press and hold the left mouse button and drag in any direction desired. As you drag, a 
rectangle forms with one corner fixed where you began to drag, and the other corner 
following the pointer.  

 Continue dragging until the rectangle is the desired size. 
 Release the mouse button. The rectangle appears on the card. 
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2.4.6 Adding Text 

 

 Click the Text tool  on the shape toolbar; the pointer changes from a pointer to a cross. 
 Move the pointer to the card work area where you want to place the text 
 Click on the card work area. A text box will appear on the card work area. 
 Double click on the text box. The Text Shape Properties Dialogue box will pop up. 

 

 
 

 Type in the desired text on the text area in the Text Shape Properties Dialogue box 
 Click OK to complete the task. 
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2.4.7 Adding Rich Text   
 

 Click the Rich Text tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the card work area where you want to place the text 
 Click on the card work area. A rich text box will appear on the card work area. 
 Double click on the text box. The Rich Text Shape Properties Dialogue box will pop up. 

 

  
 

       Type in the desired text on the text area in the Rich Text Shape Properties Dialogue box 

       Click OK to complete the task. 
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2.4.8 Adding an Image 

 Click the Image tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the card work area where you want to place the image 
 Click on the card work area. An image box will appear on the card work area. 
 Double click on the image box. The Image Shape Properties Dialogue box will pop up. 

 

 
 

 To insert a static image or picture from a list of files, click on From File. The Image File 
Dialogue box will pop up. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select the desire picture file from the list or scroll to the desired folder to find the desired 
picture file. 

 Click Open to confirm the selection. 
 Click OK in the Image Shape Properties Dialogue box to complete the task. 

 
Note: You can also add picture file from camera, video and scanner. See details on 
Chapter 4. 
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2.4.9 Adding A 1D Bar Code 

 Click the bar code tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the card work area where you want to place the bar code 
 Click on the card work area. A bar code will appear on the card work area. 
 Double click on the bar code. The Barcode Shape Properties Dialogue box will pop up. 

 
 Select a desired barcode style from the list. The default barcode style is Code 39. 
 Type in the desired data you want to embed in the barcode 
 Click OK to complete the task. 

2.4.10 Adding A PDF417 (2D Bar Code) 

 Click the PDF417 tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the card work area where you want to place the bar code 
 Click on the card work area. A PDF417 bar code will appear on the card work area. 
 Double click on the bar code. The Barcode Shape Properties Dialogue box will pop up. 

 
 Type in the desired data you want to embed in the barcode 
 Click OK to complete the task. 
 Drag the barcode box to change the desired size you want. 
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2.4.11 Adding A DataMatrix (2D Bar Code) 

 

 Click the DataMatrix tool  on the shape toolbar; the pointer changes from a pointer to a 
cross. 

 Move the pointer to the card work area where you want to place the bar code 
 Click on the card work area. A DataMatrix bar code will appear on the card work area. 
 Double click on the bar code. The Barcode Shape Properties Dialogue box will pop up. 

 

 
 

 Type in the desired data you want to embed in the barcode 
 Click OK to complete the task. 
 Drag the barcode box to change the desired size you want. 
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2.4.12 Adding A QR Code (2D Bar Code) 

       Click the QR Code tool on the shape toolbar; the pointer changes from a pointer to a 
cross. 

       Move the pointer to the card work area where you want to place the bar code 

       Click on the card work area. A QR Code will appear on the card work area. 

       Double click on the QR Code. The BarcodeShape Properties Dialogue box will pop up. 

  

 

 

 

 

 

 

 

 

  

       Type in the desired data you want to embed in the barcode 

       Click OK to complete the task. 

       Drag the barcode box to change the desired size you want. 
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2.4.13 Adding A AZTEC Code (2D Bar Code) 

       Click the AZTEC Code tool on the shape toolbar; the pointer changes from a pointer to 
a cross. 

       Move the pointer to the card work area where you want to place the bar code 

       Click on the card work area. A AZTEC Code will appear on the card work area. 

       Double click on the AZTEC Code. The BarcodeShape Properties Dialogue box will pop up. 

  

 

 

 

 

 

 

 

 

 

  

       Type in the desired data you want to embed in the barcode 

       Click OK to complete the task. 

       Drag the barcode box to change the desired size you want. 
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3. Working with Objects 
 
All cards are made up of objects. The line, text, image, barcode you use to create the card in the previous 
chapter are all objects. After inserting these objects into your card, you will then need to manipulate and 
modify the object properties to suit your card requirements.  
 

3.1 Selecting and deselecting objects 
 
In order to work on an object, you need to select it first.  
 

To select an object 
 Move the mouse pointer to a visible part of the object and click on the object. 

 
To select multiple objects 
 Hold down the Control key and click on each of the multiple objects that you want to select 

together. 
 

To deselect objects  
 Click anywhere outside the object(s). 

 

3.2 Resizing objects 
 
You can change the size of an object by dragging the sizing handles that surround a selected object. 
 

To resize an object 
 Select the object. (See previous section) 
 Move the mouse pointer over a sizing handle. The pointer changes in appearance to 

indicate the direction where you can resize the object. 
 

 
 

 Click and drag the sizing handle until the object is in the desired shape and size. 
 

3.3 Moving and Aligning objects 
 
Here you will learn how to move your objects around the card to match your requirements for the card 
design. 
  

To move an object 
 Select the object.   
 Move the pointer over the object until the pointer becomes a cross sign   
 Click and drag the object to the desired location on the card work area. 

 
Note: You can move the object to a location more precisely by disabling the snap to grid 
function. To disable it, go to menu view > snap to grid and uncheck it. 

 
To align objects 
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 Select the objects you want by mouse.  Highlight and hold the mouse click to make sure you 
cover all the objects you want.   

 Click on  for left alignment,  for right alignment,  for top alignment and  for 
bottom alignment. 

 You can make use of Ctrl + Left Mouse click to select the objects you want before selecting 
the alignment icons to align the selected group objects. 
 

To rotate an object using properties 
 Select the object.   
 Double click on the object. The object properties dialogue box pop up. 
 Click on the General tab. 

 

 
 

 Under the rotation section, input the desired amount of degrees you want the object to rotate 
to, in the clockwise direction.  

 Click OK to complete the task. 
 

Note: If you just want to rotate the object at 90 degree precisely, you can do this easily 

by clicking on the rotation toolbar. To rotate to the left at 90 degree, click . To rotate 

to the right at 90 degree, click  
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To rotate an object using mouse(Free angle rotation) 
 Select the object.   
 Move the mouse pointer over to the green box on the sizing handle. The pointer changes to 

a hand sign.  

 
 
 

 Click and drag the green box on the sizing handle towards left or right direction as required.  
 Release the mouse button after the object is rotated to the desired position. 

 

 
 

 
To stack the object   
 Select the object.  

 To send the object to the back of all other objects, click  on the toolbar 

 To bring the object to the front of all other objects, click  on the toolbar 
 

 To duplicate an object 
 Select the object.  

 Select from the menu edit > double or right click Duplicate or click on  
 The duplicated item appears on top of the object you selected. 
 

 To cut and paste an object 
 Select the object.  

 Select from the menu edit > cut or right click Cut or click on .  The object disappears. 
 Move your mouse to the position you want and select menu edit > paste or right click Paste 

or click on   
 The item re-appears on the card area you have selected. 
 

3.4 Editing objects properties 
 
Each object has its own set of properties associated to it. You can change the properties of the object 
using its properties dialogue box.  
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3.4.1 Opening properties dialogue box 

There are 3 ways to open the object properties dialogue box.  
 

To open properties dialogue box using mouse 
 Select the object.  
 Double click on the object. The object properties dialogue box pop up. 

 
To open properties dialogue box using shortcut 
 Select the object.  
 Press F2 

 
To open properties dialogue box using object list 
 Select from the menu bar File > Card Properties. 
 Click on the object list tab 

 

 
 

 Select the object whose properties you want to edit and click Properties. 

3.4.2 General properties for object 

 
All objects contain common object properties, which can be accessed from the general tab in the object 
properties dialogue box. Each can have all or some of the following properties.  
 

Bounding 
This is use to define the exact position of the object on the card work area. It can also 
define the size of the bounding box surrounding the object. 
 

Rotation 
This use to rotate the object by keying in the desired amount of degree to rotate the 
object to. You can flip the object horizontally or vertically by checking the respective 
checkbox.  
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Color and line 
This use to define the fill color of the background of the object and the border color to 
surround the object. You can also change the border width or change the borderline to 
dashed line, solid line, dotted line, dash-dot line, or dash-dot-dot line.  
 

Other 
Here, you can define whether to allow the object to be visible, transparent, read only, or 
omitted during printing. 

3.4.3 Line properties   
 
Line properties dialogue box contains the color of the line, thickness and style.  
 

 
 

3.4.4 Bounds Shape properties   

 
The rectangle, round rectangle, eclipse, pie, free line and polygon uses the bounds shape properties 
dialogue box. Bounds shape properties contain general properties such as rotation, bounding, color and 
border line. 
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To fill shapes with color,  
 Select the object.  
 Double click on the object. The object properties dialogue box pop up. 
 Click on Start Fill Color Box to choose a color to fill up.  By default, the system will auto 

populate the End Fill Color Box with the same color. 
 To change the End Fill Color box so that there is gradient filled object, click on End Fill Color 

Box to choose another color. 
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3.4.5 Text Shape properties   

 
The text shape properties dialogue box contains 2 tabs. The general tab contains the common properties 
while the text tab contains additional properties specifically for text shape properties. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Text box 
Here you can key in the required text you want it to appear on the card.  Use Ctrl + Enter 
key to enter a carriage return so that you can continue to type the next paragraph of text. 
 

Other 
Here, you can define whether to allow word wrap in the text-bounding box, change the 
text direction to vertical or even to change direction from right or left by checking the 
respective checkboxes. In additions, you can check Shrink to Fit to fit the text according 
to your text box width. 
 

Variable source 
Here, you can define other sources for the text other than keying in manually. Variable 
source will be discussed in details in Chapter 4. 

Tool bar 

Text box 
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Tool bar 
You can use the toolbar to align the text to the left, middle, or right in the bounding box 
that you have created for the text. You can apply bold, italic, underline to the text, or 
change the color of the text. You can also change the font size and font here.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.6 Rich Text Shape properties   
 
The Rich text shape properties dialogue box contains 2 tabs. The general tab contains the common 
properties while the text tab contains additional properties specifically for Rich text shape properties. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

Rich Text box 
Here you can key in the required text you want it to appear on the card.  Use Enter or Ctrl 
+ Enter key to enter a carriage return so that you can continue to type the next paragraph 
of text. 

Text box 
Tool bar 
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Other 

Here you can change the font, font size, font color of the text color, can apply both, italic, 
underline, numbering and bullets to the text, and also have undo/redo functions. 
 

Variable source 
Here, you can define other sources for the text other than keying in manually. Variable 
source will be same as text shape that discussed in details in Chapter 4.  

 
Tool bar 

You can use the toolbar to align the text to the left, middle, or right in the bounding box 
that you have created for the text. You can apply bold, italic, underline, numbering and 
bullets to the text, or change the color, font and font size of the text. You can also use the 
undo/redo button to undo or redo an action. 
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3.4.7 Image Shape properties   

 
The text shape properties dialogue box contains 2 tab, general tab and image tab.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

From File 
You can select an image file by browsing to the desired folder where your file is stored. 
 

From Face Capture 
You can capture the image from webcam with face auto-detecting function, then grab 
face photo. (Ref. below screen Face Capture) 
 

From Video 
You can capture the full image from webcam attached to your computer. (Ref. below 
screen Face Capture) 
 

From Scanner 
You can get the image source from the flatbed scanner or cameras that supports 
Windows Image Acquistion(WIA) by scanning in or capturing an image.  
 

Tools 
This allows you to modify your image with cropping function.  
 

Image Tools 
This allows you to enhance your image with many advanced image editing features. 
 

Variable source 
Here, you can define other sources for the image. Variable source will be discussed in 
details in chapter 4.  
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Screen - Face Capture / From Video 

 
To get image from Face Capture 
 In the image shape properties dialogue box, Click the button Face Capture, the 

Face Capture dialogue screen will pop up as below, click OK button to capture the 
standard size picture that in large rectangle box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To get image from Video 
 In the image shape properties dialogue box, Click the button Video Source, the 

Face Capture dialogue screen will pop up if connected to webcam, here auto-detect 
face, click OK button to capture the full picture. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Other buttons in the face capture dialogue box:  
 

1. Selects the webcam driver from the dropdown list. 
2. Load button: will load the driver and display the current video image. 
3. Grab button: will auto detect face and capture in current video image. 
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3.4.8 Barcode Shape properties   

 
The barcode shape properties dialogue box contains 2 tab, general tab and barcode tab. The 2D barcode 
(PDF417, DataMatrix, QR Code and AZTEC Code) uses the barcode shape properties.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Text area 
This allows you to key in the desired data to be embedded in the barcode.  
 

Barcode style 
Here you can select the barcode symbology you want for the barcode code while it is 
fixed for 2D barcode (PDF417, DataMatrix, QR Code and AZTEC Code).  
 

Variable source 
Here, you can define other sources for the barcode information. Variable source will be 
discussed in details in Chapter 4.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Text Area 
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Human Readable 
Check the box if you want to print the data text below the barcode.  This is not applicable 
for 2D barcode. 
 

Alignment 
This allows you align the text within the barcode object box. 
 

Ratio 
Select the ratio between the thin and thick bars.  It is only applicable to some 
symbologies.  By selecting Auto, there will be no effect by selecting the Multiplier.  The 
ratio will change automatically if you change the barcode object box size.  This is not 
applicable for 2D barcode. 
 

Multiplier 
This allows you to change the barcode size.  If the Ratio is set to 2:1, 5:2 or 3:1, and you 
start to change the Multiplier, the barcode size will increase or decrease according to the 
number selected.  Remember to change the barcode object box size to accommodate 
the change in barcode size.  This is not applicable for 2D barcode. 
 

Transparence 
This allows you set your barcode object to transparent mode.  A light background color is 
recommended in order for the barcode to be scannable.  To change the background color 
of the barcode box, click on the default white box to choose a color.  It will not be 
effective if the transparent box is checked. 
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4. Working with Variables 
 

4.1 Managing with the Variable Data 
 
When you design a card, you can insert the fixed data as well as variable data. The variable data is 
changeable automatically at the time the card is printed. It is used to eliminate the need to manually edit 
the card to enter each piece of data before printing. You can use the same card format, your card design 
will be remained constantly, only the variable data changes from card to card. 
 
Variable data is supported by the following shapes: 

 Text----Text object drawing 

 Rich Text----Rich Text object drawing 

 Image----Image object drawing 

 Bar Code----Bar code object drawing 

 PDF417----PDF417 object drawing 

 DataMatrix – DataMatrix object drawing 

 QR Code --- QR Code object drawing 

 AZTEC Code --- AZTEC Code object drawing 
  
By default all tools will be entered as fixed data because the option “Variable Source” is set to “None”. To 
enter a variable data, you need to choose a variable source from the list of variable source. 
 

4.2 The common variable sources for text properties 
 
Next, we will look into the different common variable sources in the pull down list. 
 

4.2.1 Date Time Source 
 
It allows you to define the display for system date and time.  It will extract the real data and time during 
printing. 
 

 
Style 

Provides a space to type the date and time style, commonly formats that use in Windows 
environment.  It can be any combination as follows and case sensitive: 
dd/MM/yyyy HH:mm:ss – 02/05/2007 15:35:01 
d MMM yyyy HH:mm – 2 May 2007 15:35 
h:mm tt – 2:35 pm 
dddd, MMMM dd, yyyy -  Wednesday, May 02, 2007 
 

Preview 
Displays a preview for the date and time variable. 
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4.2.2 Global Print Counter Source 

 
It allows you to define the display for the global print counter for each template. The system will auto-
update the counter for each print and continue from the last printed counter unless the current value is 
being changed. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

No of fixed digits 
Allows you to choose the number of digits you want the counter to have. 
 

Keep Leading zero 
Check the box if you would like to keep the leading zero/zeros e.g.001 

 
Increment by 

Type or select the increment value for the counter after each print. 
 

Current value 
Type or select the current value to print. 

 
Preview 

Displays a preview for the global counter variable. 
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4.2.3 Database Source 

 
It allows you to choose the table field for that will be linked to the Database.  You must make sure you are 
connected to the database before selecting this option. 
  

 
 

Select field 
Provides a list of all items in the database, double clicks each item, a relevant preview 
appears in the “Preview” space. 
 

Style  
To show or modify the selected item style. The “{0}” means “default” fieldname.   You can 
enter prefix or suffix text in front or behind the selected field.  Refer to below example: 
 

 
 

 

 
Alternatively, you can change the style for example {S,2,6} where Capital S denotes the 
substring command, the 2 denotes the starting position to extract the data and the 6 
denotes the number of digits to extract.  Refer to the example below. 
 
 
 
 
 

Prefix 

Text 
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Text 1 

{S,1,1} 

Text 2 
{S,2,6} 

 

 

Text 3 
{S,8,12} 

 

Substring 

command 

Starting 
position 

 

No. of digits 
extract 
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4.2.4 Concatenation Source 

 
It allows you to define the display for the concatenation source, with prefix, 2 sources and suffix. 

  

 
 

Prefix 
This provides a space to type any prefix text that you want to formulate.  Leave blank if 
not applicable. 

 
Source1 
To define the first variable source to retrieve.  Select from the dropdown list before clicking on the 
Properties button 
 
Separator 

Provides a space to type a separator between the 1st and 2nd source.  Leave blank if not 
applicable. 

 
Source2 
To define the second variable source to retrieve.  Select from the dropdown list before clicking on 
the Properties button 
 
Suffix 

Provides a space to type any suffix after the concatenated variables. 
Leave blank if not applicable. 
 

Preview 
Displays a preview on the concatenation variables. 
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4.2.5 Print counter Source 

 
It allows you to define the display for print counter source for each print job.  This is only applicable to 
template that linked to any database.  The system will auto-increase the counter for each record printed  
and auto-reset when the batch job is completed, that is, the number will always begin from 1 for each 
print job and increment accordingly depends on the number of records printed.  
  

 
 

No of fixed digits 
Allows you to choose the number of digits you want the counter to have 

 
Keep leading zero 

Keeps the zero/zeros ahead of the number, e.g.001 
 
Preview 

Displays a preview for the print counter variable. 
  

4.2.6 Keyboard input Source 
 
It allows you to define the display for keyboard input source. During previewing or printing, the system will 
prompt you to enter the text data that you intent to print.  The data will be discarded after each printing. 
  

 
 

Default Text 
Provides a space to type the default text.  Leave blank if you prefer a blank screen during 
data entry mode. 
 

Input Box Title 
Allows you to define the prompting box message before printing.  This prompting 
message will guide you to identify the data to be entered. 
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4.3 Variable sources for image properties 
 
Here, we will look at 3 variable sources used by image properties.  These sources allow you to place a 
static image onto your design template or a variable image during printing or previewing. 
 

4.3.1 Scan TWAIN Source 

 
It allows you to define the display for scan TWAIN source or WIA source. 
 

To get image from scan TWAIN 
 In the image shape properties dialogue box, select from variable sources list Scan TWAIN 

Source 
 Click the Get button. The scan source properties dialogue pop up 

 

 
 

 Click select source button 
 Select the data source that you want to get the data from list box. 

 

 
 

 Click select and return to the scan source properties dialogue box 
 Click start scan button. The data source dialogue box pop up 
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 Click Capture to capture scanned image. The captured image appears as thumbnail image in 
the thumb box. You can capture more than 1 image at the same time and preview them in the 
thumb box. 

 Select the desired image from the thumb box. 
 Click Transfer to transfer the desired image into iDesign and return to image shape 

properties dialogue box. 
 

 
 

 Click OK to transfer the desired image into iDesign Image box or Tools or Image Tools to edit 
the image.  
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4.3.2 Print Time Image Source 

 
It allows you to capture a face photo during printing or previewing.   

To capture image with face detecting during printing 
 In the image shape properties dialogue box, select from variable sources list Print Time 

Image Source 
 Click on Properties, the Print Time Image Source Properties dialogue screen will pop up. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Setting up for the Print Time Image Source 
In the Print Time Image Source Properties dialogue screen:  
1. Selects the webcam driver from the dropdown list. 
2. Load button: will load the driver and display the live video image at left side. 
3. Grab button: will auto detect face and capture in current video image. 
4. Auto Grab in dropdown list: during printing or previewing, system will auto detect face 

and capture the image if no image stored (Captured before), and if there is image stored 
in storage path for current record, system will take the previous image and stay at 
capturing screen, user can re-capture photo by click “Grab” button, or click “OK” button to 
use the previous photo. 
Auto Force Grab in dropdown list: during printing or previewing, system will force to 
capture the photo every print or preview. 

5. Pause Time: this is the time delay to capture photo after mouse click on “Grab” button. 
6. Storage path: this is to define photo name and storing path. Note: this setting available 

only working with database, the Photo name should use the field name with unit data (i.e. 
Staff ID). Click “Set Folder” at DB Source Property (ref. below) to set the photo storing 
path. 

7. OK button: capture the face parameter and save all the setting in this screen and exit.  
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 Capturing the photo during printing or previewing 
If there is image shape with Print Time image source, the face capture dialogue screen will 
pop up during printing or previewing. (Ref. Below), by default, system will auto detect and 
capture the photo. 
The following is to manually capturing functions. 
1. Selects the webcam driver from the dropdown list. 
2. Load button: will load the driver and display the current video image. 
3. Grab button: will auto detect face and capture in current video image. 
4. OK button: capture and cut the standard size (within Red frame) image and exit. 
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4.3.3 File Choose Source 

 
It allows you to choose an image file during printing or previewing.   
 

To get image file during printing 
 In the image shape properties dialogue box, select from variable sources list File Choose 

Source 
 Click on Properties, the File Choose Properties dialogue box will pop up. 
 

 
 

 
 

 Click Browse to select the desired folder to find the desired picture file during printing or 
previewing. 

 Enter your desired prompt message box during printing or previewing. 

 
 Click OK to confirm the settings and return to image shape properties dialogue box. 
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5. Working with Databases 
 
This chapter explains how to connect to internal as well as external database using iDesign software.  
Notes:  Different editions can access to different database modules.  Please check the brochure for 
details. 
 
 

5.1 Existing Database Connection 

 

5.1.1 Access Database Connection 

 
To connect to a mdb file 

 Select from the menu bar Database > Connect or click on  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Browse to explore your folder containing the database file you want. 
 

 
 

 Select the right database format from the dropdown list before double clicking on the right 
mdb file you want including accdb file from Office 2007. 

Click 
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 Click on OK to proceed. 

 
 

 Click on the table name you want and click OK to exit this screen. 

 
 

 Click on the table name you want and click OK to exit this screen to return to design screen. 
 You can also click on the View Data to preview the set of data that you have selected. 

Double Click to select 
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 Click on Modify Connection to change another database if you need.  Just follow the 

above mentioned steps after that.  Or click OK to exit. 
 

To view data 
 By default, the system will display the Data Browse Grid windows below the screen once 

returning to the designing mode as well as a full set of Database icons on top of the toolbar. 
 You can click on any of the column header to sort the data in descending or ascending 

order. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on  or select from the menu bar Database > Browse Data to view record by 
record as well as to perform data entry.  

Database icons 
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To auto-link objects with data  
 Click on the column you want,  hold it and drag it into your design template 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Release the mouse click and the data will be displayed in the design template. 
 

 
 
 
 
 
 
 

Data Browse  

Data Browse Grid 
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To link objects with data manually  
 Add a barcode object(Refer to Chapter 2.4.8) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select Database Source from the Variable Source dropdown list. 
 From the Properties, select the field that you would like to link this barcode object to. 
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 Click OK to exit to the design template.  Change the necessary properties accordingly. 

Refer to Chapter 3.4.7 for properties details. 
 
To link image objects with data manually (OLE Object) 

 To store image in a database like Access database, make sure the photo field in the Access 
table is of OLE object data type. 

 

 
 
 To insert photo and save it into the record, right-click on the photo field and select any of the 

various sources.  Refer to Chapter 4.3 for details.  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OLE object type 
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 Similarly, from the image object Properties, double click on the OLE Object field, for example, 
Photo to link this image object to. 

 

 
 Click OK to return to the design template screen.  

 Note: For OLE Object, you are required to insert the photo manually record by record    
 to save all the photos into the database if your picture source is From File. 
 

To link image objects with data manually (Images stored in Specified Folder) 
 Proceed to File – Option to set a path to store your picture path if you have a fixed folder to 

store your pictures and have not setup in Chapter 1.5. 
 From the image object Properties, double click on the field that you want to link to the 

filename of your picture file. 
 Click on the Set Folder if you want to select a different picture folder containing your photos. 
 Select the Picture File Format that you are using for your photos. 

 
Note:  The field that you have selected must be unique so that it can contain the  string of data 

matches the filename of your picture file.  For example:  If ID is  selected, the first record 
with ID 00001, should correspond to a physical picture filename 00001.jpg in the picture folder. 

 

  

Double-click the field 
name to be linked to 
the photo folder. 

Click to select the 

photo’s file format. 
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5.1.2 Excel File Data Connection 
To connect to an Excel file 

 Select from the menu bar Database > Connect or click on  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Click Browse to explore your folder containing the excel file you want. 
 
 
 
 
 
 
 
 
 

 Select the right format from the dropdown list before double clicking on the right xls or 
xlsx(Microsoft Excel 2007) file you want. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click 
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 Click on OK to proceed. 
 
 
 
 
 
 
 
 
 Click on the sheet name you want and click OK to exit this screen.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 You can also click on the View Data to preview the set of data that you have selected. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on Modify Connection to change another xls or xlsx Excel file if you need.  Just click 
OK to exit. 

 

Double Click to select 
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 Note:  Excel format files do not allow you to save pictures within the file.  You have to   
 store the pictures in a specified folder.  Refer to above Chapter 4.1.1 for details.  Strictly   
 no record adding or deleting for Excel format files within iDesign.  However, you can edit   
 the data and save it. 

   

5.1.3 CSV File Data Connection 
 

To connect to a CSV file 

 Select from the menu bar Database > Connect or click on  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Browse to explore your folder containing the excel file you want. 
 
 
 
 
 
 
 
 

 Select the right format from the dropdown list before double clicking on the right csv file you 
want. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click 
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 Click on OK to proceed. 
 
 
 
 
 
 
 
 

 Click on the file name you want and click OK to exit this screen.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 You can also click on the View Data to preview the set of data that you have selected. 
 
 Click on Modify Connection to change another format or csv file if you need.  Just click OK 

to exit and follow the usual steps to view or edit data. 
 

 Note:  CSV format files do not allow you to save pictures within the file.  You have to   
 store the pictures in a specified folder.  Refer to above Chapter 4.1.1 for details.  Strictly   
 no record adding or deleting for CSV format files within iDesign.  However, you can edit   
 the data and save it.  Make sure your 1st row of data contains the record header. 

 
 
 
 
 
 

Double Click to select 
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5.1.4 MS SQL Database Connection 
 

To connect to a MS SQL Database 
 

 Create a new design template as shown on the screen below. 

 Select from the menu bar Database > Connect or click on  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Advance to explore your folder containing the excel file you want. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click 
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 Select Microsoft OLE DB Provider for SQL Server and click Next to continue. 

  
 Select the SQL Server Name. 

 

Click 
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 Select the right login authentication and database on the server. 
 

 
 Click Test Connection to check the connectivity to your selection.  The system will display a 

message box once it is connected successfully. 

 

Select the option to 
log on to the SQL 

server 

Select a database 
from the SQL server 

specified 
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 Click OK to continue and exit from the Advance connection screen. 
 You will get to see a list of tables from the Northwind database.  Click on Employees table 

to select and click on OK to exit to design template screen.  

 
 Refer to Chapter 5.1.1 for standard data viewing and data linking in details. 

 
Notes:  Similar to Access database, before you can save the photo in the SQL database, 
make sure the photo field in the SQL database table is of image data type. 

 
 

  
 

  
 
 
 
 
 
 
 

5.1.5 Data Filtering 
 
Once you have connected to any form of database, you can select data to view or print.  You can be very 
specific to filter to one record or a group of records that fulfill your criteria. 
 

To filter records 

Image type 
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 Make you have connected to any form of database. 

 Click on   to filter data. 

 
 You can only filter up to a maximum of 4 criteria.  Select the field from the dropdown box. 

 
 Select the operand from the list provided and enter your criteria into the box provided. 

 
 Click OK to start filtering data or Clear to reset the criteria. 
 
Note:  By saving the template design, the filtering criteria will always remain applicable till a reset 
is being done and followed by another re-saving of template.  
 
To search for a particular record, make sure you make use of an unique field likes ID and enter 
the exact data in the criteria box in order to match completely. 

 
If an empty Data Browse Grid is displayed after you have set your criteria, it means there is no 
record that fulfills the criteria. 

List of  data fields 

List of Operands 

Criteria Box 
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5.2 New Internal Database Connection 
Instead of making use of external database via another software, you can create your own database to 
store data according to your own needs. 

 
To create database 

 Select from the menu bar Database > Connect or click on  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Create Database to create a new database.  

 
 

 Enter a database name, for example, Employee and click Save button.  
 

 
 
 
 

Click 
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 Click on New Table to create a table. 

 
 Enter the table name, for example, Staff_info. 
 Next, specify all the field names row by row.  Make sure you have an unique key to one of your 

fields in your table to identify your record, especially if you are storing your picture as an external 
jpg or bmp file and link to one of fields to identify the record uniquely. 
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 To remove a particular field, highlight the field and click Remove.  To save the table, click on OK 
to save. 

 
 

 Click on the table, Staff_Info before clicking on OK to return to the design template screen. 
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 By default, the system will display the data grid window for you to enter new data into the new 
table.  Refer to Chapter 5.1.1 for data entry and linking details. 
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6. Printing With iDesign 
 
This section explains how to print cards with iDesign. For specific information about your printer, please 
refer to your printer user manual. 

 
6.1 Print Setup 
   
 To setup a printer before printing 

 To setup printing, select File > Print Setup. The print setup dialogue box pops up.  
 

 
 

   Under the Destination, the system will display the default printer name.  Click down arrow to 
view and choose a list of window driven printers.  Click the “Properties” button to display or 
change the printer properties according. 

 
 To change the page size or card size, click on the dropdown list to select a size from the 

provided list. 

  
 



 68 

 You have a choice to select the layout to be printed as well as whether just to perform card 
encoding alone.  Check the boxes according to your requirements. 

 
 

   You can set the number of copies you want to print for each record by change the value.  This 
will print the repeated information on multiple cards based on your specified.copies. 

 
 

   To change the orientation of the template, you have to click on Portrait or Landscape. 

 
 

 If your template is linked to any form of database, the database section will be displayed for  
 you to make the necessary changes.  You can check on the boxes to print all records or only 

records that you have selected.  Refer to next section on how to select records to print.  Print 
All option will print all records that you have filtered(Refer to Chapter 5.1.5 for data filtering).   

 
 By checking Keep Db Position, the system record pointer will remain pointing at the same 

record even after the printing.  By unchecking the box, the pointer will point at the last record of 
your selection. 

 

 
 
 

6.2 Select Record(s) to print 
 
 To select a record, range of records or multiple records  to print 

 On the data grid windows, move your cursor to the record you want and click on the row to 
highlight the record. 

 For range of records selection,  click on the first record, hold on to the Shift key followed by 
the last records within the range.  The whole blank of records will be highlighted. 
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 For multiple records selection, click on the first record, hold on to the Ctrl key and continue to 
click on the record you want till you have completed your selection. 

 

 
 
 

6.3 Preview card 
  
 To preview card(s) 

 You can preview the template layout before printing by clicking on  the  Preview button 
on the Standard Toolbar or Select File > Preview from the menu.  By default, the system will 
display the front page of 1st record printout.   

 
 

 You can click on  to zoom in or out.  You can also click on  to display 
the printout in 2 pages, 3 pages, 4 pages or 6 pages within one windows screen, for example, 
6 pages icon was selected as follows: 
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 Click on  at the right top corner to change page number you want to display if 
your selection contains more than 1 record. 

 Click on   to print all cards that you are previewing currently. 
 
 

6.4 Print card 
  
 To print card(s) 

 To quickly print a card design template, click the  “Print” button on the Standard 
Toolbar or use shortcut key “Crtl+P”. 

 
 OR 
 

 Select File > Print 
 Configure the print setup dialogue box to fit your needs 
 Click OK to print card  
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7. Logins and Passwords 
iDesign allows you to define authorized users to access to the system.  This allows you to control the 
accessibility of each module to different users. 
 

7.1 Administrator Login 
 
 To Enable Login 

 To enable login, you have to proceed to File > Login to open up the below screen: 

 
 Under the Users list window, click on administrator to highlight.  
 Uncheck the box:  Disable Login Control. 
 Remember to change the default password and Confirm Password and click on Save to 

save the password. 
 Click on OK to exit this screen.  Once you exit the application completely, you will be always 

prompted to login when you access the application till you re-access the Login Control screen 
and check the box: Disable Login Control. 

 
      Notes: 

1) Once you enable login id by removing the check on the Disable Login Control and save 
it, the Login feature is enabled.  Similarly, if you check the box against the Disable Login 
Control and save it again, the Login feature is disabled. 

2) The default login id and password is administrator if you have not changed your 
password. 

3) Once you click OK to exit this screen and exit from the application, the system will prompt 
you a login screen. 
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 To Add New User  
 To add new user, you have to proceed to File > Login to open up the below screen: 
  

 
 

 Click on Add before entering the Login Name, Password and Confirm Password.   
 Check on the check boxes under the Permissions Windows: 

  
 Click OK to save all changes. 
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8. Magnetic Encoding 
This module allows you to encode data into your magnetic strip that comes with the card.   Of course, 
your printer must equip with the magnetic encoder before getting the cards encoded and according to 
ANSI and ISO/IEC standards. 
 

Track Maximum number of Character 

1 79 alphanumeric 

2 40 numeric 

3 107 numeric 

 
 

8.1  Setting Up 
  
 To setup for encoding 

 Click on   to open up the Magnetic Encoding screen: 

   
 

 Select the track that you would like to encode and check on the box besides the prompt:  
Encode 

 To encode fixed text, enter your data into the Data to Encode box. 

  
 If you would like to link to database variable or other forms of variables, click on the 

dropdown list box to select.  Refer to Chapter 4 on Working with Variables for details. 
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 Click OK to save the settings and exit from this screen.  
 
Notes:  You have to remember to check on the Card Encoding Check Box under the Print Dialog 
window if you would like to print and encode at the same time.  Please remove the check boxes 
for Print Front and Print Back if you would like to encode the cards only.
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9. Keyboard shortcuts 
 
Use the following key combinations to execute the command listed next to it. When the keys are 
connected by a +, it means to press both keys at the same time. 
 
File Menu 

New----Creates a new design template Ctrl + N 
 

Open----Opens an existing design template Ctrl + O 
 

Save----Saves an active design template  Ctrl + S 
 

Print----Prints the current design template  Ctrl + P 
 

Card Properties----Card information Ctrl + F2 
 

 
Edit Menu 

Undo----Undoes the last action.  Ctrl + Z 
 

Cut----Cuts the selection and puts it on the clipboard. Ctrl + X 
 

Copy----Copies the selection and puts it on the clipboard Ctrl + C 
 

Paste----Inserts data from clipboard. Ctrl + V 
 

Duplicate----Duplicates selection. Ctrl + D 
 

Delete----Deletes selection. Del 
 

Properties----A selected object Information F2 
 

 
Others 

Card Front---- Views front card layout Ctrl + F 
 

Card Back----views back card layout Ctrl + B 
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10. Menu Commands 
 
This section summarizes the commands available in the iDesign menus. 
 

10.1  File Menu 
 

New Command 
To create a new card design template 
 
Open Command 
To open an existing card design template 
 
Close command 
To close the active design template and save it  
 
Save command 
To save the active card design template with name and location  
 
Save As command 
To change the name or location of an existing card design template when saving  
 
Card Setup command 
To set up a card size and orientation  
 
Print Setup command 
“Print Setup” command is used for printing control 
 
Language Command 
To select the language you want to display 
 
Preview command 
To display a preview for the current design template before printing 
 
Logins command 
Configuration of user login, password and area access  
 
Card Properties command 
Card Properties command is used to display information about the card design template. 
 
Options command 
To specify default directory and folder for the card design template  
   
Exit command 
To close all iDesign windows 

 

10.2   Shape menu 
 

Text Command 
To define a text object on the card 
 
Rich Text Command 
To define a rich text object on the card 
 
Image command 
To insert an image which already exists 
 
Line command 
To draw a line on the card 
Rectangle command 
To draw a rectangle on the card 
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Round Rectangle command 
To draw a round rectangle on the card 
 
Ellipse command 
To draw an ellipse on the card 
Pie command 
To draw a pie on the card 
 
Free Line command 
To draw a free line on the card 
 
Polygon command 
To draw a polygon on the card 
 
Barcode command 
To insert a bar code in the card 
 
PDF417 command 
To insert a PDF417 in the card 
 
Data Matrix command 
To insert a Data Matrix in the card 
 
Overlay Varnish command 
To overlay some place which not be printed in the card 

 

10.3   Edit menu 
 

Undo command 
To reverse the last command or action 
 
Redo command 
To reverse the action of the “Undo” command 
 
Cut command 
To remove selected drawing objects and put them on the clipboard 
 
Copy command 
To copy a selected drawing object to the clipboard 
 
Paste command 
To insert a copy from the clipboard into the card design template 
 
Duplicate command 
To duplicate a drawing object 
 
Delete command 
To remove a drawing object 
 
Bring to Front command 
To put the selected drawing object above another one 
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Send to Back command 
To put the selected drawing object below another one 
 
Rotate -90 command 
To rotate the selected drawing object counter-clockwise by 90 degree 
 
Rotate 90 command 
To rotate the selected drawing object clockwise by 90 degree 
 
Flip Vertical command 
To make the selected drawing object vertically 
 
Flip Horizontal command 
To make the selected drawing object horizontally 
 
Properties command 
To display the properties dialog box for the selected drawing objects 

 

10.4   Format menu 
 

Font command 
The “Font” command is used to open the font dialog box, which allows you to change the 
appearance of individual characters 
 
Bold command 
To make the text heavier and darker 
 
Italic command 
To make the text slope to the right 
 
Underline command 
To make the text be underlined 
 
Fill Color command 
To fill the color into the selected drawing shape 
 
Border Color command 
To change the color of the selected shape 
 
Font Color command 
To change the front color of a shape 
 
Align Left command 
This command allows the selected object flush against the left margin 
 
Align Center command 
This command allows the selected object is aligned with the mid point between the left and right 
margins 
 
Align Right command 
This command allows the selected object flush against the right margin 
 
Border Style command 
To change the border style of the selected drawing shape 
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Border Width command 
To change the border width of the selected drawing shape 

 

10.5   Database menu 
 

Database Command 
To connect to a data source 
 
Data Browse command 
To browse the records in the database 
 
Data Browse with Grid command 
To browse the records with grid 
 
Add New command 
To add new records to the table 
 
Delete command 
To remove records from the table 
 
Save to Database command 
To save the current record into the database 
 
First command 
To find the first record on the current table 
 
Prior command 
To find the previous record on the current table 
 
Next command 
To find the next record on the current table 
 
Last command 
To find the last record on the current table 
 
Filter command 
To filtrate some records when browse data 

 

10.6   View menu 
 

Card Front command 
To see the front card layout 
 
Card Back command 
To see the back card layout 
 
Metrics command 
To change the default measurement unit 
 
Zoom in command 
To zoom in the design template 
 
Zoom out command 
To zoom out the design template 
 
 
View Scale command 
To configure the view scale 
 
Show Grid command 
To show or hide the grid on the screen 
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Snap to Grid command 
To use the “Snap to Grid” command so that you align the object bounding to the grid points 
 
Toolbar command 
To show or hide any of the individual toolbars 
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11. Toolbar Commands 
 
This section provides a summary of the Card Software tools.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.1 Standard toolbar 
 

 
 

 New -- To create a new card design template 
 

 Open -- To open an existing card design template 
 

 Save -- To save the active card design template with name and location  
 

 Preview -- To preview card design template before printing 
 

 Print -- To print current card design template 
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11.2 Edit toolbar 
 

 
 

 Undo - Reverses the last action. 
 

 Redo - Redoes the last action that was undone. 
 

 Cut -Deletes the selected object and places it on the Clipboard so you can paste it 
elsewhere. 

 

 Copy - Makes a copy of the selected object and places it on the Clipboard. 
 

 Paste - Pastes the object from the Clipboard onto the card. A copy of the pasted    
           object remains on the clipboard until it is replaced by another cut or copy   
           command. 
 

 Duplicate - Makes a copy of an object and places it slightly overlapping the  
                               original. 
 

 Delete – Delete a selected object 
 

 Send to Front - Moves the selected object to the front of a stack of objects. 
 

 Send to Back - Moves the selected object to the back of a stack of objects. 
 

 Rotate -90o – Rotate the selected object by -90 degrees 
 

 Rotate 90o – Rotate the selected object by 90 degrees 
 

 Flip vertical - Flip the selected object vertically 
 

 Flip horizontal - Flip the selected object horizontally 
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11.3  Shape toolbar 
 
  
 
 

 Text - Defines a text field. 
 

 Rich Text - Defines a rich text field. 
 

 Image - Draws a frame to contain an image. 
 

 Line - Draws a line  
 

 Rectangle - Draws a rectangle or square 
 

 Rectangle - Draws a round rectangle   
 

 Eclipse - Draws a eclipse   
 

 Pie - Draws a pie   
 

 Free line - Draws a free line  
 

 Polygon - Draws a polygon   
 

 Bar code - Draws a bar code symbol. 
 

 Bar code PDF - Draws a bar code PDF symbol. 
 

 Data matrix - Draws a data matrix symbol   
 

 QR Code  - Draws a QR Code symbol   
 

 AZTEC Code  - Draws a AZTEC Code symbol   
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11.4  Format toolbar 
 

 
 

 Font - to open the font dialog box, to change the appearance of individual characters 

 Bold - To make the text heavier and darker 

 

 Italic - To make the text slope to the right 
 

 Underline - To make the text be underlined 

 

 Fill color - To fill the color into the selected drawing shape 

 

 Border color - To change the color of the selected shape 

 

 Font color - To change the front color of a shape 

 

 Left - allows the selected object flush against the left margin 
 

 Centre - allows the selected object is aligned with the mid point between the left and right 
margins 
 

 Right - allows the selected object flush against the right margin 
 

 Border style - To change the border style of the selected drawing shape 

 

 Border width - To change the border width of the selected drawing shape 
 

 Align Left - To change the border width of the selected drawing shape 
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11.5  Database toolbar 
 

 
 

 Database - To connect to a data source 
 

 Filter - To filter through data 
 

 Data browse - To browse the records in the database 
 

 Data browse grid - To browse the records with grid 
  

 Add new – Add new data to database record 
 

 Delete – Delete selected data 
 

 Save to database - To save the current record into the database 
  

 First - To find the first record on the current table 
  

 Previous - To find the previous record on the current table 

  

 Next - To find the next record on the current table 

  

 Last - To find the last record on the current table 
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11.6 Smart Card toolbar 

  

 
 
 

 Magnetic encoder - To edit magnetic encoding properties 
 

 Contact smart card - To insert contact smart card 
 

 Contactless smart card - To insert contactless smart card 
 

 Overlay varnish - To insert overlay varnish 
 

 Card front side - To see the front card layout 

  

 Card back side - To see the back card layout 
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12. Barcode Blocker 
 
12.1   Creating Barcode Blocker 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right-Click / double-click the 
barcode shape to view its 
properties as shown. 

• Make sure the Transparent 
checkbox is unchecked. 

• Click on the color box to 
change the background color 
of the barcode.  

Click to select the preferred 
color of your choice. 

Click OK to confirm the 
chosen color. 
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Click Apply button and the background color of 
the barcode will be changed as shown above. 

• Insert a Box shape as shown above. 

• Right-click / Double-click to view its properties as shown 
above. 

• Click on the Start Fill Color box. 
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• Click to select the same color as the barcode 
background color, which you have chosen earlier 
in the beginning. 

• Click OK button to confirm the chosen color. 

The background color of the Barcode and the Box fill color 
MUST BE the same in order to create a barcode blocker.  
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Right-click on the Box shape and select Send to Back as shown above. 

• Move the barcode so that it’s position is within the box boundary as shown 

above. 

• The barcode blocker is successfully created. 


